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I. Document Control 
This document is the official user manual for EPCplanner 2026. It is controlled by the EPCplanner product 
owner. Modifications to this document must be reviewed and approved before distribution to client or pilot 
organisations. 
 

Document Property Detail 

Document Title EPCplanner 2026 — User Manual 

Document Reference EPCplanner-UM-2026 

Revision V1.0 R1 

Status Issued for Pilot Use 

Date June 2026 

Owner / Author EPCplanner Product Team 

Classification Confidential — Authorised Pilot Organisations Only 

Platform Windows · Android · iOS · macOS (Mac Catalyst) 
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II. Revision History 
 

Rev Date Author Description of Change 

R0 May 2026 EPCplanner 
Team 

Initial draft for internal review. All 14 sections and 49 
workflow screens covered. 

R1 June 2026 EPCplanner 
Team 

CBS workflow subsections (Section 7.2–7.7) expanded with 
full step text. Section 8.6 Historical Reports and Section 9.9 
Register Summary Reports populated. 
 
Document Control, Revision History, Glossary, 
Recommended Implementation Sequence, Administrator 
Pre-Deployment Checklist, and Enterprise Release 
Improvement Notes added. 
 
Added three positioning chapters: “Why EPCplanner — 
Single Source of Truth”, “System Workflow Overview” (with 
end-to-end architecture diagram), and “Governance 
Framework: Historical Snapshots, Freeze Guard & Audit 
Log”. 
 
Replaced workflow diagram with updated two-phase 
architecture (Project Setup Phase / Operational Reporting 
Cycle). Added three chapters: “Project Controls Philosophy”, 
“Reporting & Measurement Framework”, and “Register 
Progress Logic” (with calculation-sequence diagram). 
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III. Why EPCplanner — Single Source of Truth 
 
The Problem with Fragmented Project Controls 
On most EPC projects, the schedule lives in Primavera P6, the commercial baseline lives in a spreadsheet, 
engineering deliverable status lives in another spreadsheet maintained by Document Control, procurement 
status lives with the procurement team, and subcontractor progress lives with the construction team. Each 
of these sources is updated on its own schedule, by different people, with different assumptions about 
what “done” means. 
 
As a project grows past a few hundred activities and a few thousand deliverables, these fragmented 
spreadsheet-based registers become difficult to control, audit, validate, and align with the schedule. 
Reconciling Engineering, Procurement, and Subcontractor registers against the Primavera schedule 
becomes a recurring manual exercise — repeated every reporting period, prone to version conflicts, and 
difficult to defend during a claim or audit. 
 
EPCplanner replaces this network of fragmented register spreadsheets with a controlled, database-driven 
workflow. Every Engineering document, Procurement requisition, and Subcontract package lives in one 
structured database, linked directly to the Primavera schedule and to the commercial Cost Breakdown 
Structure. There is one place where progress is entered, one place where it is validated, and one place 
from which every report — technical or commercial — is generated. 
 

Concern Traditional Spreadsheet Approach EPCplanner Approach 

Data Location Scattered across multiple Excel files 
held by different teams. 

One project database covering 
schedule, commercial, and all register 
data. 

Schedule Alignment Manual cross-checking of register dates 
against P6 activity dates each period. 

Each register item is linked to a task 
code; Validation reports day-delta gaps 
automatically. 

Period Lock Closed-period figures can be silently 
edited; tracing changes is difficult. 

Freeze Guard blocks retroactive entry 
once a Cut-Off Date is closed. 

Audit Trail Reconstructed manually from file 
versions and email history, if at all. 

Immutable Audit Log records every 
controlled action with user, timestamp, 
and detail. 

Commercial Linkage Physical progress and invoicing tracked 
in separate, loosely reconciled files. 

CBS, Activity WF, and Cost/Invoice WF 
are linked — one progress update 
drives both. 

 
EPCplanner Complements Primavera P6 — It Does Not Replace It 
EPCplanner is not a Primavera replacement and not an attempt to move scheduling logic out of P6. 
Primavera P6 remains the master schedule, holding the Level 3 CPM logic — typically 5,000 to 10,000 
activities for a major EPC project. 
 
The detail that would otherwise bloat that schedule to 30,000–50,000 activities — individual engineering 
documents, individual purchase requisitions, individual subcontract deliverables — is instead tracked at 
Level 4/5 inside EPCplanner’s Register module, linked back to the relevant Level 3 activity. P6 stays clean 
and manageable for the planning team, while EPCplanner carries the operational detail and feeds 
summarised progress back to P6 through the two-way synchronization described in the next section. 
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IV. What EPCplanner Actually Is 
EPCplanner is best described not as a reporting tool, and not as a Primavera add-on, but as an EPC 
Project Controls Operating System. A single application manages: 
 

• Planning — schedule intake and two-way synchronization with Primavera P6. 
• Commercial Progress — CBS, Weight Factors, and invoice/payment certificate generation. 
• Engineering Deliverables — document register, stage gates, and review status. 
• Procurement Deliverables — purchase request tracking through to delivery. 
• Subcontract Packages — subcontractor deliverable tracking and payment linkage. 
• Forecasting — lookahead and behind-schedule analysis for short-interval planning. 
• Governance — role-based access, immutable audit logging, and period-lock controls. 
• Reporting — S-curves, tabular progress, histograms, register packs, and feedback forms. 

 
Each of these capabilities individually exists in some form elsewhere — in a spreadsheet, a separate tool, 
or a manual process. What makes EPCplanner different is that they operate on the same database, the 
same WBS, and the same period structure, so a single progress update cycle keeps planning, commercial, 
and reporting outputs consistent with each other. 
 

Five Things That Make EPCplanner Different 
Differentiator What It Means in Practice 

Single Source of Truth One local-first database holds schedule, CBS, Weight Factors, and all register 
data — every report is generated from the same underlying figures. 

Register-Driven 
Progress 

Physical progress is calculated from real deliverable completion (drawings issued, 
PRs placed, subcontract gates met) rather than from estimated percentages. 

Historical Period Control Every closed Cut-Off Date is preserved as a locked historical snapshot, available 
for trend analysis and audit at any later date. 

Forecasting Integration Lookahead and Behind-Schedule reports are generated directly from the live 
register and activity data — no separate forecast spreadsheet to maintain. 

Primavera 
Synchronization 

Two-way connection reads the P6 schedule and writes actual progress, dates, and 
remaining duration back — keeping P6 current without manual re-entry. 
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V. System Workflow Overview 
EPCplanner’s workflow divides into two distinct phases. The first is a one-time Project Setup Phase, 
completed before any reporting begins, which establishes the schedule baseline, commercial structure, 
weight factors, and register framework. The second is a recurring Operational Reporting Cycle, which 
repeats for every Cut-Off Date (COD) and includes actual updates, rollup, reporting, two-way 
synchronization with Primavera P6, and period closure. Where the cycle identifies trends that require a 
formal response — a schedule revision, recovery plan, or rebaseline — a Management of Change process 
is triggered, managed through Plan Versioning (Chapter 14). The diagram below shows both phases 
together, with each stage referenced to the relevant chapter of this manual. 

 
Figure 0.1 — EPCplanner end-to-end workflow architecture: the one-time Project Setup Phase (top) and the recurring 

Operational Reporting Cycle (bottom), connected by two-way synchronization with Primavera P6. 
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Project Setup Phase (One-Time) 
These six steps are completed once per project, before any Cut-Off Date is opened. They establish the 
schedule baseline, commercial structure, weight factors, and register framework, and conclude with formal 
validation and the switch to In-Progress mode that locks the baseline for operational reporting. 
 

Step What Happens Manual Reference 

1. Primavera P6 Master Schedule (Level 3) is imported via XER or connected live 
(Oracle/SQL Server/SQLite) — WBS, Activities, Calendars, 
Relationships. 

Section 4 

2. CBS Cost Breakdown Structure is imported, reviewed, validated, and 
promoted — the commercial baseline and bill of quantities. 

Section 7.1–7.5 

3. Weight 
Factors 

Progress weighting is generated and validated — Activity WF and 
Cost/Invoice WF, both linked to the CBS distribution. 

Section 6, Section 7.7 

4. Register 
Framework 

ENG / PROC / SUBC registers are imported and configured — 
stage templates, stage logic, and task code linkage to the 
schedule. 

Section 9.3–9.6 

5. Reports & 
Measurement 
Framework 

S-curves, tabular progress, histograms, register packs, 
invoices, lookahead, and behind-schedule reports templates 
are generated for use. 

Section 10 

6. Baseline 
Validation 

Quality check, validation, and alignment of all setup data against 
the approved baseline, ready for formal approval. 

Section 9.6 

7. Switch to In-
Progress Mode 

The baseline is locked. The project is now ready for operational 
reporting and the first Cut-Off Date can be opened. 

Section 8.1 
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Operational Reporting Cycle (Recurring) 
Once the project is in In-Progress mode, these eight steps repeat for every Cut-Off Date. Each cycle 
captures actual progress, recalculates Register and Activity status, generates forecasts and reports, 
synchronizes with Primavera P6, and closes with a locked Historical Snapshot of that period (see 
Governance Framework, page 9). 
 

Step What Happens Manual Reference 

1. Open Cut-Off 
Date (COD) 

Define the reporting period and lock the update window for the 
new period. 

Section 8.2 

2. Actual 
Updates 

Register stage actuals and linear Activity actuals are entered — 
actual dates, percent complete, remaining duration. 

Section 8.3–8.4 

3. Reg Rollup 
(Register 
Rollup) 

Calculate Register progress as of the COD and roll it up to linked 
Activities using Weight Factors. 

Section 8.5 

4. Run Update Calculate overall Activity progress as of the COD, combining 
linear progress and Register Rollup. 

Section 8.5 

5. Forecast & 
Lookahead 

Forecast dates and completion projections are generated. Trend 
analysis is performed across closed periods to identify slippage 
patterns. Where negative trends or schedule deviations are 
identified, changes to the forecast are documented and form the 
basis for a Management of Change assessment — which may 
trigger a Revision, Recovery Plan, or Rebaseline in the next cycle 
(Chapter 14). 

Section 10.5–10.6 

6. Reports & 
Analysis 

S-curves, tabular progress, histograms, register packs, invoices, 
lookahead, and behind-schedule reports are generated for issue. 

Section 10 

7. P6 Update 
(Two-Way Sync) 

Calculated actual dates, percent complete, and remaining 
duration are pushed back to the connected Primavera P6 
database. 

Section 4 

8. Close Cut-Off 
Date (COD) 

Lock the period — no further changes allowed. The system 
creates a Historical Snapshot, and the cycle repeats for the next 
Cut-Off Date. 

Section 8.5–8.6 

Management of Change (MOC) — triggered by the recurring cycle 
 
At the close of each reporting cycle, the trend analysis and forecast output from Step 5 may indicate that the 
current approved plan is no longer achievable. Where this is formally recognised, a Management of Change 
process is initiated — resulting in one of the following actions, each managed through Chapter 14 (Plan 
Versioning):  
(a) a Revision to reflect approved scope or sequence changes;  
(b) a Recovery Plan to address schedule slippage with a Revised Cut-Off Date that locks actual progress to date; 
or  
(c) a Re-baseline, formally approved by the Client or PMC, that resets the reference plan.  
 
These actions do not interrupt the Operational Reporting Cycle — they update the active plan version against 
which the next cycle runs. 
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VI. Governance Framework: Historical Snapshots, Freeze 
Guard & Audit Log 

Three EPCplanner capabilities work together as a single governance system: Historical Snapshots, Freeze 
Guard, and the Audit Log. Individually, each addresses a specific control need. Together, they give Clients, 
PMC organisations, and auditors confidence that reported progress figures are accurate, traceable, and 
cannot be altered after the fact without a visible record. This chapter describes the three capabilities 
together as the governance layer that underpins every other module in EPCplanner. 
 
Why This Matters 
Project progress data is used for far more than internal tracking. It feeds monthly invoicing, supports claims 
and variation negotiations, and is reviewed by Clients and PMC organisations who were not present when 
the data was entered. When a dispute arises about progress reported three, six, or twelve months earlier, 
the question is rarely “what is the progress now” — it is “what was reported then, who entered it, and has 
it changed since.” EPCplanner is built to answer all three questions directly from the database, without 
reconstruction from file versions or email threads. 
 
Historical Snapshots 
Every time a Cut-Off Date is closed, EPCplanner preserves the complete state of that period: register 
actuals, activity progress percentages, S-curve data points, CBS earned values, and the timestamp of the 
update. This is not a manual export — it happens automatically as part of closing the period, and the 
resulting snapshot cannot be edited afterwards (see Freeze Guard, below). 
 
Historical Snapshots are accessed through the Historical Reports screen (Section 8.6) and support several 
uses that go well beyond simple record-keeping: 
 

• Trend Analysis — compare progress velocity across multiple closed periods to identify slippage 
patterns before they become critical. 

• Audit Support — respond to internal or external audit requests by reproducing the exact figures 
reported for any historical Cut-Off Date, with no risk that current-period edits have altered them. 

• Claims and Variation Support — provide contemporaneous progress evidence for delay 
analysis, extension-of-time claims, or variation valuation, drawn directly from the period in 
question rather than reconstructed afterwards. 

• Retrospective Performance Review — at project close-out or lessons-learned reviews, 
reconstruct the project’s progress history period by period without relying on archived 
spreadsheets of varying quality. 
 

Freeze Guard 
Freeze Guard is the control that makes Historical Snapshots trustworthy. Once a Cut-Off Date is closed, 
Freeze Guard prevents actual dates, quantities, and stage completions from being entered or modified for 
that period — from any module, by any user, including Administrators acting through normal data-entry 
screens. 
 
This is the feature most valued by Client and PMC reviewers, because it directly answers a recurring 
concern with spreadsheet-based reporting: that figures issued for a closed period can be quietly revised 
in a later update with no record of the change. With Freeze Guard active, a correction to closed-period 
data requires a deliberate, logged action rather than a routine edit — and that action itself is captured in 
the Audit Log. 
 
In practice, Freeze Guard means that the S-curve, register status, and CBS earned value reported to the 
Client for Period N will read exactly the same in EPCplanner six months later as they did on the day Period 
N was issued — a guarantee that few spreadsheet-based systems can offer. 
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Audit Log 
The Audit Log is often introduced in user manuals as an administrative screen for reviewing user activity. 
Within EPCplanner’s governance framework it serves a broader purpose: it is the record that connects 
every figure in every report back to the user, action, and timestamp that produced it. Combined with the 
11-role RBAC model (Table 12.1), the Audit Log provides four distinct functions: 
 

• Traceability — every import, validation run, rollup, update, and report generation is logged with 
the responsible user and timestamp, so any reported figure can be traced back to the action that 
created it. 
 

• Governance — role-restricted actions (CBS promotion, period close, mode switches) are 
recorded against the authorising user, supporting separation-of-duties requirements common in 
EPC contracts. 
 

• Claims Support — when a claim or dispute requires evidence of when information was known or 
recorded, the Audit Log provides a timestamped record independent of the reports themselves. 
 

• Audit Compliance — internal and external auditors can review the log directly to confirm that 
controlled actions were performed by appropriately authorised roles, without requesting ad-hoc 
evidence from the project team. 

 
How the Three Work Together 
The three capabilities are deliberately interdependent. Freeze Guard ensures that a Historical Snapshot, 
once created, represents an unalterable record of what was reported. The Audit Log records the close 
action that created the snapshot and any subsequent authorised correction. Historical Snapshots then 
make that locked-down history usable — turning it from a passive safeguard into an active reporting and 
analysis resource. 
 
Together, this governance layer is one of the strongest reasons a Client or PMC organisation will support 
the adoption of EPCplanner on a project: it does not just produce reports faster, it produces reports whose 
history can be trusted. 
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VII. Project Controls Philosophy 
EPCplanner is built around a set of project controls principles intended to ensure that planning, progress 
measurement, forecasting, and reporting are generated from a single controlled process. These principles 
are not optional configuration choices — they are embedded in how the application structures data and 
enforces workflow, and they apply to every project regardless of size or contract type. 
 

Single Source of Truth 
All project progress calculations, forecasts, and reports are generated from a common data structure. This 
eliminates the need for multiple disconnected spreadsheets and reduces reporting inconsistencies across 
project functions. 
 
Register-Driven Progress Measurement 
Progress is measured through Engineering, Procurement, and Subcontract Registers using configurable 
stage templates and Weight Factors. Activity progress is therefore derived from actual deliverable status 
rather than manual percentage entry. 
 
Controlled Reporting Cycle 
Each reporting period operates through a formal Cut-Off Date (COD) cycle. Progress updates, rollups, 
forecasts, and reports are generated using controlled procedures to ensure consistency and repeatability. 
 

Historical Data Preservation 
Closed reporting periods remain protected through Cut-Off Date controls and Freeze Guard mechanisms. 
Historical project status can therefore be reviewed and reported without retrospective modification. 
 
Primavera Synchronization 
EPCplanner integrates with Primavera P6 through schedule import and controlled progress 
synchronization, maintaining alignment between schedule management and physical progress 
measurement. 
 

Governance and Traceability 
All controlled actions are recorded through Audit Log mechanisms, providing full traceability of project 
updates, administrative actions, and reporting activities. 
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VIII. Reporting & Measurement Framework 
Before a project enters In-Progress Mode, EPCplanner requires the establishment of a Reporting & 
Measurement Framework. 
 
This framework defines how project performance will be measured, calculated, presented, and distributed 
throughout the project lifecycle. 
 
The framework typically includes: 

• Progress Measurement Methodology 

• Weight Factor Structure 

• S-Curve Configuration 

• Activity Spread Configuration 

• Resource Histogram Configuration 

• Tabular Report Definitions 

• Lookahead Reporting Parameters 

• Behind Schedule Analysis Criteria 

• Report Layouts and Print Settings 

• PDF, Excel, and HTML Output Formats 
 

The Reporting & Measurement Framework is configured during the Project Setup phase and becomes 
part of the approved project baseline. 
 
Once operational reporting begins, all reporting outputs are generated from the approved framework, 
ensuring consistency between reporting periods and preventing uncontrolled changes to project 
measurement methodology. 
 
This approach ensures that project progress, forecasting, and management reporting remain aligned 
throughout the project lifecycle. 
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IX. Register Progress Logic 
The Register Framework forms the core progress measurement engine within EPCplanner. 
 
Engineering, Procurement, and Subcontract deliverables are managed through Registers using 
configurable stage templates. Each stage represents a measurable milestone within the deliverable 
lifecycle and can be assigned a proportional Weight Factor contribution. 
The progress calculation process follows the sequence shown below: 

 
Figure 0.2 — Register Progress Logic: the calculation sequence from individual register items to project-level progress, 

forecasting, and reporting. 
 
This methodology allows project progress to be calculated from actual deliverable achievement rather than 
subjective percentage estimates. 
 
Because all calculations originate from controlled register data, progress reporting remains traceable, 
auditable, and consistent across Engineering, Procurement, Subcontracting, and Project Controls 
functions. 
 
The same progress dataset is subsequently used for S-Curves, Histograms, Tabular Reports, Forecasting, 
Lookahead Analysis, Behind Schedule Analysis, and Primavera P6 synchronization. 
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1. Application Access Flow 
This section covers the startup path a user follows on first launch: license activation on Windows, login, 
and mandatory password change when the account requires it. 
 

1.1 License Activation 
On Windows, EPCplanner verifies the local machine license before the login screen appears. If no valid 
license is found, the License Activation page opens and blocks access until activation succeeds. 
 

Step Action Expected Result 

1 Start EPCplanner. The application opens and checks the machine 
license. 

2 If unlicensed, remain on the License Activation 
page. 

The machine fingerprint and request data are 
displayed. 

3 Copy the machine fingerprint or export the license 
request. 

The request can be sent to the EPCplanner 
License Manager. 

4 Paste the generated license key in the activation 
field. 

The key is ready for validation. 

5 Click Activate. The license is stored on the machine and the 
application proceeds to login. 

• Use Copy Machine Fingerprint when only the device identity is required. 
• Use Copy License Request or Export License Request when the full request payload is needed. 
• If activation fails, verify that the key was generated for the same machine fingerprint shown on 

screen. 
• License activation is a Windows-only startup requirement before any operational screens become 

accessible. 
 

NOTE 
The license is tied to a single machine fingerprint. Never apply a key generated for a different machine. 

 
Figure 1.1 — License Activation page. Copy the Machine Fingerprint or export the License Request, then paste the activation 

code received from the EPCplanner License Manager. 
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1.2 Login 
After successful license activation, the login page is presented. Access is controlled by role and 
permission mapping assigned by the system administrator. 
 

Step Action Expected Result 

1 Enter your Username. The user account is ready for authentication. 

2 Enter your Password. Use the eye button to reveal 
temporarily if needed. 

The password field accepts the credential. 

3 Click Login. The application validates the account and opens 
the main shell. 

 
• User accounts and roles are created and managed by the Administrator. 
• If login fails, verify the username, password, account active status, and whether a forced 

password change is pending. 
• Access rights are controlled by role and permission mapping — use approved accounts only. 

 

 
Figure 1.2 — Login page. User accounts and roles are controlled by the Administrator. 
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1.3 Mandatory Password Change 
When an account is flagged for first-time login or forced update, EPCplanner opens the Change 
Password screen before granting access to operational modules. 
 

Step Action Expected Result 

1 Enter the current password. Default is: 
Welcome@12345 

The application confirms the account identity. 

2 Enter a new password meeting the policy 
requirements. 

The new password must meet the complexity 
policy. 

3 Confirm the new password. The confirmation must match exactly. 

4 Click Change Password. The account is updated and the user proceeds to 
the application. 

 

IMPORTANT 
Password policy: minimum 12 characters including uppercase, lowercase, a digit, and a symbol. The new 
password must differ from the current password. 

 
• Cancel should only be used when the password change is not mandatory; otherwise the user 

cannot proceed to normal work. 
 

 
Figure 1.3 — Change Password page. Change the default password on first login. 
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2. Main Screen and Navigation 
After successful login, the EPCplanner main shell becomes the working hub. All modules and workflows 
are launched from the top-level navigation and feature commands. 
 

• File actions: database lifecycle (new, open, backup, restore), logout, and exit. 
• Project actions: project setup, XER import, Primavera connections, and project selection. 
• Module access: CBS, Weight Factors, Register, Progress Update, Reports, and Settings are 

accessed from dedicated pages. 
• Administration screens are role-sensitive — some actions only appear or function for Admins. 

 

IMPORTANT 
Complete the Project Setup and P6 import before using any downstream module. All modules depend on a 
correctly initialized project database. 

 

 
Figure 2.1 — Main application shell. All modules and commands are accessible from the top-level navigation. 
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3. Project Databases 
EPCplanner operates on a local-first model. The SQLite project database file is the single source of truth 
for all project data. Treat the database file as the project file itself. 
 

3.1 Create a New Project Database 
Step Action Expected Result 

1 Select File → New Project. The application prompts for a database location 
and file name. 

2 Choose the save folder and enter the file name. A new SQLite project database file is created. 

3 Wait for schema initialization to complete. The project database is ready for setup and data 
loading. 

 
3.2 Open an Existing Database 

Step Action Expected Result 

1 Select File → Open Database. A file picker dialog opens. 

2 Navigate to and select the required project 
database file. 

The database opens and becomes the active 
project. 

3 Verify the correct project is active before 
continuing. 

All subsequent operations target the selected 
database. 

 

 
Figure 3.1 — New / Open database flow. Use File → New Project Database to create, and File → Open Database to open an 

existing project. 
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3.3 Backup and Restore 
Step Action Expected Result 

1 Use Backup Database before major imports or 
structural updates. 

A backup copy of the active database is created. 

2 Store the backup in a controlled folder with a dated 
name. 

Recovery is possible if a later step fails or corrupts 
data. 

3 Use Restore Database only when intentionally 
rolling back. 

The selected backup replaces the current working 
state. 

 
• Recommended: create a backup before XER import, major register import, large template changes, 

or migration work. 
• Name backups with clear dates and milestones — example: ProjectA_before_XER_2026-03-23. 
• Restore is a corrective action. Confirm the correct target file before proceeding. 

 
 

 
Figure 3.2 — Backup and Restore commands. Always back up before any major import or structural operation. 
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4. Primavera P6 Integration 
EPCplanner integrates with Primavera P6 through two complementary pathways: XER file import for 
universal schedule intake, and direct database connection (Oracle, SQL Server, or standalone SQLite) for 
live two-way synchronization including progress push-back to P6. 
 
4.1 Import Primavera XER 
XER import loads WBS, activities, resources, relationships, and all related schedule data into the 
EPCplanner project database. This is the standard entry point for schedule-based workflows. 
If a plan version already exists for the project, importing a new XER opens the Plan Revision dialog before 
the import proceeds, so the new schedule can be recorded as a Revision, Recovery Plan, Rebaseline, or 
Forecast. See Chapter 14, Plan Versioning, for the full workflow. 
 

Step Action Expected Result 

1 Select Project → Import XER. The file selection dialog opens. 

2 Pick the required XER file. The application reads and profiles the file schema. 

3 Confirm and run the import. WBS, activities, relationships, resources, and 
calendars are loaded. 

4 Wait for normalization and mapping to 
complete. 

The project database is populated with schedule data 
ready for reporting and rollup. 

 
• After import, review the WBS structure, activity list, calendars, and relationships before proceeding 

to dependent workflows. 
• If Register rollup will be used, verify that the activity IDs and task codes are correct before linking 

register items. 
 

 
Figure 4.1 — XER import flow. Use Project → Import XER to load Primavera schedule tables into the project database. 
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4.2 Connect to Primavera Database 
EPCplanner supports direct connection to Primavera P6 databases — Oracle, SQL Server, and 
standalone SQLite. Connection profiles are saved and named for controlled multi-environment use. Only 
Administrators can create Oracle or SQL Server connections; other users may create local SQLite 
connections. 
 

Step Action Expected Result 

1 Open the Primavera Connection screen. Available connector options are displayed. 

2 Select the connector type (Oracle / SQL Server 
/ SQLite) and profile name. 

The connection detail fields become editable. 

3 Enter or browse the database path or server 
connection string. 

The connection can be tested and saved. 

4 Test the connection. A success or failure status is returned immediately. 

5 Browse the EPS tree and select the target 
Primavera project. 

The project is linked to the EPCplanner database. 

 
• Use named profiles (for example: Production, Test, Client-Copy) for controlled environments. 
• Oracle and SQL Server connections are restricted to Administrator role — keep under admin 

control in shared workstation environments. 

TIP 
The P6 connection supports both Read (import) and Write (progress push). Progress push transfers actual 
progress, actual dates, and remaining duration from EPCplanner back to the live P6 project. 

 

 
Figure 4.2 — Primavera connection page. Administrators manage Oracle and SQL Server profiles; other users may create local 

SQLite connections. 
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4.3 Select Project from EPS Tree 
The Primavera project picker presents the EPS tree in the same familiar view used in Primavera P6. Select 
the correct project carefully — all subsequent imports and progress push operations target this selection. 
 

 
Figure 4.3 — Primavera project picker. Used for both importing the schedule and exporting actual progress back to the P6 

project. 
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5. Project Setup 
Project Setup stores the project identity and operating rules used across all modules and reports. Complete 
this section early, before any major data imports. 
 

Step Action Expected Result 

1 Open Project Setup. The project setup page appears. 

2 
Enter project identity fields: project name, client 
project number, company project number, 
revision number, and issuance number. 

Project metadata becomes available across all 
reports. 

3 Define cut-off settings and reporting period 
logic. 

Weekly and monthly routines use consistent period 
logic. 

4 Save the changes. The active project keeps the updated settings. 

 
• Cut-off logic is critical — progress updates and actual date validation rules depend on it. 
• Complete project setup before large data imports to ensure correct metadata appears in all 

generated reports. 
 

 
Figure 5.1 — Project Setup page. Configure project identity, cut-off settings, and reporting parameters before importing 

schedule data. 
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6. Weight Factors Workflow 
Weight Factors (WF) distribute measurable planning weight across activities or CBS items based on 
configured scope logic. Correct WF distribution is the foundation for accurate progress calculation and S-
curve generation. When a CBS is in use, Weight Factors are generated automatically from the CBS–
Activity distribution (Section 7.7) and transferred here. Complete the CBS workflow (Section 7) before 
configuring Weight Factors manually. 
 

Step Action Expected Result 

1 Open the Weight Factors screen. The WF workspace is ready. 

2 Export the WF Template from the toolbar. A blank Excel template is generated for data entry. 

3 Fill in the WF data in the template and save. The template is ready for import. 

4 Import the completed WF Excel file. Weight values are loaded into the current database. 

5 Review totals and alignment with the intended 
scope. 

Incorrect distributions can be identified and corrected. 

6 Save and proceed to dependent workflows. WF-based calculations become available in reports 
and rollups. 

 
• Review total weight logic after every import. The total must equal 100% across the applicable 

scope. 
• Do not proceed to formal reporting until the WF distribution is fully validated. 

 

NOTE 
Weight Factors directly drive S-curve generation, progress rollup, and CBS progress calculation. An incorrect 
WF distribution will produce incorrect results across all dependent reports. 

 

 
Figure 6.1 — Weight Factors screen. Import and validate weight distribution before proceeding to progress workflows. 
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6.1 Transfer Weight Factors 
Use Transfer WF to roll up and transfer Register weight factors to the corresponding Activity weight factors. 
This links the register progress measurement system to the schedule-based progress engine. 

 
Figure 6.2 — Transfer Weight Factors screen. Transfers Register WF values to Activity WF for unified progress rollup. 
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6.2 Weight Factor Alignment 
Weight Factor Alignment provides a side-by-side comparison between Activity progress WF and 
Cost/Invoice WF. Use this to detect and resolve any discrepancies between the physical progress 
measurement basis and the commercial measurement basis before issuing invoices or progress 
certificates. 

 
 

 
Figure 6.3 — Weight Factor Alignment screen. Compare progress WF against Cost/Invoice WF to validate consistency before 

formal issuance. 
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7. CBS Workflow 
The Cost Breakdown Structure (CBS) module manages the lump-sum price schedule, activity-to-bill 
linkage, invoice generation, and CBS-based reporting. CBS operates in conjunction with Weight Factors 
to calculate commercial progress and generate payment certificates. 
 
7.1 Typical CBS Sequence 

Step Action Expected Result 

1 Open the CBS workflow screen. The CBS workspace is ready. 

2 Import CBS data from Excel using the mapper. Staged data is loaded with field mapping applied. 

3 Validate the imported CBS data. Structural and mapping issues can be corrected 
before promotion. 

4 Promote validated CBS data. The CBS becomes the active commercial baseline. 

5 Link CBS items to WBS/Activities using CBS 
Distribution. 

Cost and progress relationships are established. 

6 Generate WF from the CBS-Activity mapping. Weight factors are automatically calculated from the 
bill structure. 

7 Export or report CBS data and generate 
invoices. 

Controlled payment certificate outputs are ready for 
issue. 

 
• Validate before promoting — mapping issues detected early avoid costly corrections downstream. 
• Link quality matters: downstream invoice calculations and progress reporting depend on clean 

activity relationships. 
• CBS reports and invoice print workflows should be verified after each major data refresh. 

 
Figure 7.1 — CBS workflow screen. The main CBS workspace showing the bill structure and workflow controls. 
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7.2 Import CBS data 
CBS data is loaded from an Excel template using a field mapper. Export the blank template, populate it 
with contract line items and pricing, then import the completed file. The mapper aligns source columns to 
the CBS target fields before staging the data for validation and promotion. 

 
Figure 7.2 — CBS Import screen. Export the blank Excel template, populate it with contract line items and pricing, then import 

the completed file using the field mapper. 
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7.3 CBS Review 
CBS Review presents the staged import data in tabular form before promotion. Use this screen to inspect 
all loaded line items, verify quantities, unit rates, and totals, and confirm that the field mapping has 
produced the correct values. Identify and correct any errors at this stage before proceeding to Validation. 

 
Figure 7.3 — CBS Review screen. Inspect all staged line items, verify quantities, unit rates, and totals before proceeding to 

Validation. 



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 32 

7.4 CBS Validation 
CBS Validation checks the staged data against structural rules before promotion is permitted. Issues such 
as missing item codes, zero-value line items, duplicate entries, or mapping gaps are listed with 
descriptions. Resolve all validation errors before proceeding to Promote. Items with warnings should be 
reviewed and either corrected or accepted with documented justification. 

 
Figure 7.4 — CBS Validation screen. Structural checks against the staged data, listing missing item codes, zero-value lines, 

duplicates, and mapping gaps that must be resolved before promotion. 
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7.5 CBS Promote 
CBS Promote converts the validated staged data into the active commercial baseline. Once promoted, the 
CBS becomes the reference against which all activity linkage, weight factor generation, and invoice 
calculations operate. Promotion is a controlled one-way action — ensure validation is fully resolved and 
the data has been reviewed before executing. A database backup before promotion is recommended. 

WARNING 
CBS Promote is a one-way action that cannot be undone through normal operations. Take a database backup 
immediately before promoting. Once the CBS is active, re-importing or re-promoting CBS data will overwrite the 
existing commercial baseline and recalculate all linked Weight Factors, invoices, and progress data. 

 

 
Figure 7.5 — CBS Promote screen. Convert validated staged data into the active commercial baseline. A database backup is 

recommended before this controlled, one-way action. 
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7.6 CBS Distribution 
CBS Distribution manages the mapping between CBS items, WBS nodes, and activities. This mapping 
drives weight factor generation and determines how commercial progress is attributed across the project 
breakdown structure. 

 
Figure 7.6 — CBS Distribution screen. Map CBS items to WBS/Activities to establish the commercial progress basis. 
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7.7 CBS Weight Factor 
CBS Weight Factor generates activity weight values automatically from the CBS-Activity distribution 
mapping. Once generated, these values populate the Weight Factors module and form the basis for 
physical progress calculation, S-curve generation, and period reporting. Review the generated values for 
completeness and total distribution before proceeding to progress update workflows. 

 
 

Figure 7.7 — CBS Weight Factor screen. Activity weight values generated automatically from the CBS-Activity distribution 
mapping, ready for review before progress update workflows begin. 

  



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 36 

7.8 CBS Invoices and Reports 
The CBS invoice and reporting module generates formal payment certificate outputs, print previews, and 
packaged review documents. Invoices are composed from the CBS-Activity mapping and current progress 
data. 
 

• Use Print Preview before final PDF issuance to verify layout and calculated amounts. 
• CBS invoice templates are customizable to match contract requirements. 
• Verify invoice data against the validated progress update before issuing to the client. 

 

 
Figure 7.8 — CBS invoice and report screen. Generate, preview, and export formal payment certificate outputs. 

 
  



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 37 

8. Progress Update Workflow 
The Progress Update module converts the project from baseline-oriented planning into controlled actual 
progress tracking and period reporting. It manages the full update cycle: linear activity progress, register 
progress rollup, S-curve update, and P6 write-back. 
 
8.1 Switch to In-Progress Mode 
Before the first progress update, an Administrator must switch the project to In-Progress mode. This locks 
the planning baseline and activates progress workflows. 
 

Step Action Expected Result 

1 Open Admin Settings. The administration panel appears. 

2 Select the active project. Mode controls become available for the chosen 
project. 

3 Enable In-Progress Mode. The planning baseline is locked and progress 
workflows activate. 

 

IMPORTANT 
Only an authorised Administrator should perform the In-Progress mode switch. This action is non-reversible — 
it permanently locks the planning baseline. Ensure all planning data (P6 import, CBS, Weight Factors, Register 
setup) is finalised, validated, and backed up before switching. Take a named baseline backup immediately 
before this action. 

 

 
Figure 8.1 — Admin Settings mode switch. Switch from Planning to In-Progress mode to activate progress tracking. 
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8.2 Open a Cut-Off Date (COD) 
Each reporting cycle begins by opening a Cut-Off Date. All progress entries and updates within the cycle 
are tied to this date. Use one controlled COD per reporting period. 

WARNING 
Closing a COD is a controlled, irreversible action under normal operations. Once closed, Freeze Guard prevents 
any retroactive entry of actual dates or stage completions for that period. Reopening a closed COD requires an 
authorised Administrator action and is logged in the Audit Log. Confirm that all actuals are entered, Reg Rollup 
and Run Update are complete, and reports have been reviewed before closing the COD. 

 
Figure 8.2 — Progress Update dashboard. Set the cut-off date and select the update mode before entering actua 
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8.3 Linear Progress Update 
Linear Progress Update is used to enter physical progress, actual start date, actual finish date, and 
remaining duration for activities that are not linked to Engineering, Procurement, or Subcontractor 
registers. 
 

• Enter actual progress percentage for each active activity. 
• Update actual start and finish dates where applicable. 
• Set remaining duration for activities that are started but not complete. 

 

 
Figure 8.3 — Linear Progress Update screen. Enter physical progress, actual dates, and remaining duration for non-register 

activities. 
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8.4 Register Progress Update 
Register Progress Update allows actual stage dates to be entered for all register types (Engineering, 
Procurement, and Subcontractor). Stage completion automatically drives activity progress through the WF-
based rollup engine. 

NOTE 
Entering actual stage dates here records the data but does not yet calculate activity progress. Activity progress 
percentages are only updated when Reg Rollup is run in Section 8.5. Always complete all stage actuals entry 
before running Reg Rollup. 

 

 
Figure 8.4 — Register Progress Update screen. Enter actual stage dates for ENG, PROC, and SUBC register items. 
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8.5 Complete the Update Cycle 
After all actual inputs are entered, run the update sequence in order to calculate and lock the period 
results. 
 

Step Action Expected Result 

1 Click Reg Rollup. Register progress is calculated as of the Cut-Off Date 
(COD). 

2 Click Run Update. Activity progress is calculated as of the COD for all 
linear activities. 

3 Click S-Curve. The S-curve data is updated with the current period 
actual progress. 

4 Click P6 Update. Actual dates, physical progress %, and remaining 
duration are pushed to the live Primavera P6 project. 

5 Click Close COD. The period is locked. No further changes can be made 
retroactively. 

6 Before opening a new COD, click Save LW/LM. Last Week and Last Month values are saved as the 
reference baseline for the next period. 

 
 

 
Figure 8.5 — Progress Update toolbar. Complete the full update cycle in sequence before closing the Cut-Off Date. 

 

IMPORTANT 
Always run the steps in order: Reg Rollup → Run Update → S-Curve → P6 Update → Close COD. Skipping or 
reordering steps will produce inconsistent results. 
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8.6 Historical Reports 
The Progress Update module retains a full history of closed cut-off periods. Historical Reports allow review 
of any previously closed period’s progress data including register actuals, activity progress percentages, 
S-curve data points, and update timestamps. Use historical reporting for trend analysis, audit support, and 
retrospective review of project performance against the baseline. 

 

 
Figure 8.6 — Historical Reports screen. Review any previously closed period’s progress data for trend analysis, audit support, 

and retrospective performance review. 
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9. Register Workflow 
The Register module is the core tracking engine for Engineering deliverables, Procurement purchase 
requests, and Subcontractor work packages. It uses template-driven stage logic to calculate plan dates, 
late dates, and track actual completion against each gate. 
 
 

 
Figure 9.1 — Register grid and toolbar. The main Register workspace showing the item list and workflow controls. 

 
 
9.1 Register Concept 

• ENG register: document-based business key — DOC_NUMBER. 
• PROC register: procurement business key — PR_NUMBER. 
• SUBC register: subcontract package key — SUBC_NUMBER. 
• Business keys must remain stable across revisions to preserve controlled update history and 

linkage integrity. 
• Multiple templates with different stage counts can coexist in the same project — for example: 6 + 

5 + 5 + 7 + 3 + 2 stages across different document families. 
 
 
 

IMPORTANT 
The Register module replaces fragile Excel register networks by making the project database the single source 
of truth. Excel is used for import/export only — all templates, dates, actuals, and reporting are managed inside 
EPCplanner. 
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9.2 Standard Register Sequence 
Step Action Expected Result 

1 Open the Register module and select the 
register type (ENG / PROC / SUBC). 

The register grid and toolbar are available. 

2 Import the register from Excel using field 
mapping and upsert mode. 

Items are loaded or updated without creating 
duplicates. 

3 Create, import, or review stage templates. The stage structure is ready for assignment. 

4 Assign template and link task code to each 
item. 

Each item is connected to stage logic and a schedule 
reference activity. 

5 Generate stage dates (plan and late). Date calculations run with warnings shown for 
misalignments. 

6 Run Quality check. Template coverage and structural setup issues are 
identified. 

7 Run Validation. Register-to-schedule alignment gaps are listed with 
day deltas. 

8 Update Actual and Forecast values via the 
stage edit form. 

Stage progress is recorded and outputs update 
immediately. 

9 Generate reports, exports, and stage matrix 
output. 

The register package is ready for review or formal 
issue. 

 

 
Figure 9.2 — Register workflow toolbar. The toolbar sequence supporting the Standard Register Sequence: Import, Templates, 

Assign/Link, Generate Dates, Quality, Validation, Actual/Forecast Updates, and Reports. 
 
When more than one plan version exists for the project, a "Compare with..." chip bar appears above the 
Register grid, adding read-only previous-plan date columns and a colour-coded variance column. See 
Chapter 14, Plan Versioning, Section 14.6. 
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9.3 Excel Import and Field Mapping 
Register items are imported from Excel using a field mapping interface. Upsert behavior updates existing 
items based on the business key instead of creating duplicates, preserving all existing linkage and 
history. 

• Map source columns carefully so they land in the correct target fields. 
• Always use upsert mode to update items without duplicating records. 
• Review imported counts and sample rows before continuing to template assignment. 

 

 
Figure 9.3 — Register import field mapping. Map Excel columns to EPCplanner fields and use upsert mode to preserve existing 

linkage. 
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9.4 Stage Templates 
Templates define the stage sequence, gate names, default durations, and stage weights used by each 
item family. Different templates with different stage counts can coexist within the same project. 
 

• Keep template naming clear and consistent so users assign the correct template to each item type. 
• Template stage counts are flexible — each template independently defines its own gate sequence. 
• Templates can be exported to Excel, modified, and reimported. 

 
Figure 9.4 — Template management screen. Create and manage stage templates for ENG, PROC, and SUBC register item 

families. 
  



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 47 

9.5 Assign Template and Link Task Code 
Template and task code assignment is one of the most critical control steps in the register workflow. It ties 
each register item to both its stage logic and its Primavera schedule reference activity. 

• Assign the correct template based on the document or package family and stage count agreement. 
• Link the appropriate Primavera task code (also referred to as Activity ID) to establish date alignment 

and progress linkage. 
• Incorrect assignment at this step will propagate to all downstream date calculations and rollup. 

 

 
Figure 9.5 — Assign template and task code. Link each register item to its stage template and Primavera activity reference. 
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9.6 Generate Dates, Quality, and Validation 
After template assignment, generate plan and late stage dates. Review all warnings before proceeding — 
they indicate missing inputs, duration gaps, or schedule misalignments. 

• Generate dates after template assignment and duration setup are complete. 
• Review all warnings - do not ignore them. They typically indicate missing inputs or weak 

assumptions. 
• Quality confirms structural coverage: every item has a valid template and required setup. 
• Validation highlights alignment gaps between the register dates and the linked Primavera activity 

dates, showing day deltas for each discrepancy. 

 
Figure 9.6 — Generate dates and warnings screen. Review all warnings before proceeding to quality and validation. 

 
Figure 9.7 — Quality and Validation results. Review all issues before releasing the register for progress update. 
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9.7 Actual and Forecast Updates 
Use the stage edit form to capture actual completion dates and forecast update dates for each gate. This 
data feeds stage-level progress control, S-curve calculation, and automatic rollup to linked activities. 
 

• Actual dates must be within the open Cut-Off Date period — the Freeze Guard prevents retroactive 
entries. 

• Forecast dates should be maintained for all incomplete stages to keep the completion projection 
current. 

• Stage progress automatically rolls up to the linked activity and contributes to the period progress 
calculation. 

 

 
Figure 9.8— Actual and Forecast edit form. Enter actual completion and forecast dates for each stage gate. 

 
 
 

TIP 
For Third-Party Register Validation (e.g., receiving a Subcontractor engineering register): import the external 
register, anchor by business key, assign templates, link task codes, then run Validation to generate an 
acceptance QA exceptions pack. 
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9.8 Register Reports and Exports 
The Register module produces a full suite of output formats for formal issue, review, and analysis. 
 

• Full Register Report (HTML / Excel / PDF): complete issue pack with filters, grouping up to 3 levels, 
and stage column selection. 

• Stage Matrix Export: compact Excel format for stage-by-stage review and pivot analysis. 
• Weekly / Monthly Summary: Plan vs Actual comparison for progress reporting periods. 
• Rollup to Activities: use only after register content is validated and actuals are current. 
• Report Preview: before the Register Summary or Stage Matrix (Pivot) Excel export is written to 

disk, an HTML preview opens showing the report exactly as it will appear in Excel, including the 
same header, actual-date, and variance colour formatting. Use the column chips in the preview to 
confirm the selected pivot columns before confirming the export. If the preview fails to render, the 
export proceeds directly to Excel without blocking the workflow. 

 
Figure 9.9 — Register report options. Select output format, grouping level, and stage columns before generating the register 

pack. 
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Figure 9.10 — Register report output. Full register report with stage matrix and progress status indicators. 
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9.9 Register Summary Reports 
Register Summary Reports provide period-level plan versus actual comparisons in a condensed format 
suitable for management review and weekly or monthly progress meetings. The Weekly Summary and 
Monthly Summary outputs display planned completion counts, actual completion counts, and variance by 
register type and grouping level. These reports complement the full register pack with a focused view of 
period performance rather than full item-level detail. 
 

 

 
Figure 9.11 — Register Summary Report output. Weekly/Monthly plan versus actual comparison, showing planned and actual 

completion counts and variance by register type and grouping level.  
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10. Reports Module 
EPCplanner provides a comprehensive reporting suite covering S-curves, tabular progress, resource 
histograms, behind-schedule analysis, lookahead schedules, and feedback forms. Reports are available 
in HTML, Excel, and print-optimized PDF formats. 
 

Step Action Expected Result 

1 Open the required report from the Reports 
toolbar. 

The report setup or generation screen opens. 

2 Configure report parameters: grouping, period, 
page size, stage columns. 

The report is configured for the intended audience and 
purpose. 

3 Generate preview or export. The output is displayed or saved in the selected 
format. 

 

 
Figure 10.1 — Reports toolbar. Access all report types from the unified Reports module. 
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10.1 S-Curves 
S-curve reports display the cumulative planned progress against actual progress over the project 
timeline. EPCplanner generates S-curves from the Weight Factor-based rollup engine, supporting both 
overall project curves and register-specific curves. 

 
Figure 10.2 — S-Curve form inputs. Configure project and date range parameters before generating the curve. 

 
Figure 10.3 — S-Curve report output. Plan vs Actual cumulative progress with period data table. 

 

The S-Curve definition screen includes a Plan Version selector, allowing curves from more than one plan 
version (for example Baseline and Recovery Plan) to be overlaid on the same chart. See Chapter 14, Plan 
Versioning, Section 14.6. 
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10.2 Tabular Progress Report 
The Tabular Progress report presents period-by-period planned and actual progress in a structured table 
format, supporting multi-level WBS grouping and historical period comparison. 

 
Figure 10.4 — Tabular Report form inputs. Configure WBS grouping, date range, and column selection. 

 

 
Figure 10.5 — Tabular Report output. Period-by-period progress table with plan, actual, and variance columns. 
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10.3 Spread Setup (Activity Curve) 
Spread Setup supports activities whose progress follows a plan/actual curve profile — such as project 
management activities, supervision, or lump-sum scope items not covered by register deliverables. 
Select the target activity and configure the spread distribution. 
 

 
Figure 10.6 — Spread Setup form inputs. Configure spread parameters for activities using curve-based progress tracking. 

 

 
Figure 10.7 — Activity picker for Spread Setup. Select the target activity from the schedule list. 
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10.4 Resource Histogram 
The Resource Histogram displays planned and actual resource loading by period. Use it to identify 
peaks, shortfalls, and resource allocation issues across the project timeline. 
 

 
Figure 10.8 — Resource Histogram form inputs. Configure resource filters and date range. 

 
 

 
Figure 10.9 — Resource Histogram output. Planned vs actual resource loading by period with peak identification. 
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10.5 Behind Schedule Report 
The Behind Schedule report identifies register items and activities where actual or forecast dates have 
slipped past their planned or late dates. Day delta values quantify the severity of each delay for 
prioritization and corrective action. 
 

 
Figure 10.10 — Behind Schedule form inputs. Configure filter criteria and threshold for delay reporting. 

 

 
Figure 10.11 — Behind Schedule report output. Items sorted by delay severity with day delta values. 
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10.6 Lookahead Schedule 
The Lookahead report presents upcoming register stages and activities due within a configurable 
forward window (typically 3 to 6 weeks). Use it for weekly coordination meetings and short-interval 
planning. 
 

 
Figure 10.12 — Lookahead Schedule form inputs. Configure the lookahead window and filter criteria. 

 

 
Figure 10.13 — Lookahead Schedule output. Upcoming stage gates and activities due within the selected window. 
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10.7 Feedback Form 
The Feedback report exports an Excel form that can be distributed to field teams, engineering leads, or 
subcontractors to collect actual dates and progress updates. Completed forms are imported back into 
EPCplanner, eliminating manual re-entry. 

• Linear Activities feedback: exports activity progress and actual date fields for field or office-based 
updates. 

• Register feedback: exports stage actual date fields for engineering, procurement, or subcontractor input. 
• Both form types support filter facilities to limit the export to relevant scope subsets. 

 
Figure 10.14 — Feedback form for Linear Activities. Export and distribute for field progress collection. 

 
Figure 10.15 — Feedback form for Register items. Distribute to engineering and procurement teams for stage actual date input. 
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11. Print Settings and Export Options 
Shared print settings control page orientation, scale, and paper size for all HTML and PDF outputs 
across all EPCplanner modules. 
 

Step Action Expected Result 

1 Open Print Settings from the toolbar or module 
menu. 

Shared formatting preferences for all report outputs are 
available. 

2 Set page orientation, scale, and paper size. All subsequent print and PDF exports use the 
configured settings. 

3 Generate preview or export from the active 
module. 

The output is formatted according to the saved print 
settings. 

 
• Review output scale and page orientation before large PDF issuance. 
• For very large reports, reduce unnecessary columns or split outputs by area when practical. 
• HTML export is suitable for browser-based review; PDF export is suitable for formal distribution. 

 

 
Figure 11.1 — Print settings screen. Configure shared page layout preferences for all print and PDF outputs. 
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12. User Management and Administration 
 
12.1 User Management 
The User Management screen allows Administrators to create, edit, and deactivate user accounts. Each 
account is assigned a role that controls the permission set within EPCplanner. 
 

Step Action Expected Result 

1 Open User Management (Admin only). The user list and selected user panel appear. 

2 Select an existing user or click Add New. The account form opens for editing or creation. 

3 Set the role and complete all required fields. The user profile is configured with the appropriate 
permissions. 

4 Save the user record. The account is active and available for login. 

 
• A newly added user receives a temporary password (Welcome@12345) and is required to 

change it on first login. 
• Role is the primary access control point — assign the minimum role required for the user's 

responsibilities. 
• Delete a user account only when you are certain it is no longer required; consider deactivating 

instead to preserve audit trail integrity. 
 

Role Primary Access Scope 

Admin Full system access — users, settings, mode switch, all data. 

Project Controls Manager Approve, promote, close periods, full reporting access. 

Project Controls Engineer Full planning + CBS read + report generation. 

Planner Register and stage editing, progress entry rights. 

Commercial User CBS import, validate, promote, invoicing, WF management. 

Document Controller Transmittal, distribution management, submittal tracking. 

Construction Manager Site diary, resource management, field progress approval. 

Subcontract Coordinator Package management, subcontractor progress, payment. 

QA/QC Engineer Inspection records, punch items, NCR tracking. 

Client Read-only access to reports and dashboards. 

Viewer Read-only access to views and reports. 

 
Table 12.1 — EPCplanner user roles and primary access scope. 
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Figure 12.1 — User Management screen. Create and manage user accounts and role assignments. 

 

  



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 64 

12.2 Admin Settings 
Admin Settings provides mode switching, cut-off date management, and Primavera connection profile 
control for the active project. 

• Use Admin Settings for In-Progress mode switching — this is a one-way, non-reversible action 
for each project milestone. 

• Reopen closed cut-off dates only with a valid documented reason and in accordance with audit 
discipline. 

• Keep all administrator actions controlled and traceable — they affect operational governance and 
data integrity. 

 

 
Figure 12.2 — Admin Settings screen. Mode switch, cut-off date management, and Primavera profile controls. 
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12.3 Audit Log 
The Audit Log records all controlled administrative and data actions with timestamp, user identity, and 
action details. Review it when traceability is required for governance, dispute resolution, or compliance 
purposes. 
Plan version lifecycle events (import, approval, activation, and Revised Cut-Off Date locks) are recorded 
separately in the Plan Event Log for each plan version. See Chapter 14, Plan Versioning, Section 14.5. 

• Audit log entries are immutable — they cannot be edited or deleted by any user including Admin. 
• Export the audit log to Excel for formal submission or archiving when required. 
• Filter by user, date range, or action type to locate specific events efficiently. 

 

 
Figure 12.3 — Audit Log screen. Full tamper-proof record of all controlled system and data actions. 
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13. Settings, Utilities, and Troubleshooting 
 
13.1 General Utilities 

• Settings and theme controls: usability preferences that do not affect project data or workflow state. 
• Table Viewer: direct tabular inspection of underlying database tables — use for diagnostics and 

data verification. 
• Logout: cleanly closes the active session. Always log out before switching users on a shared 

workstation. 
 
 

13.2 Troubleshooting Checklist 
# Symptom Resolution 

A License activation rejected. Verify the generated key belongs to the exact machine fingerprint 
shown on the activation page. Keys are machine-specific and non-
transferable. 

B Login fails repeatedly. Check username, password, account active status. Confirm whether a 
forced password change is pending. 

C Wrong database opened. Close the current database and reopen the correct project file before 
any import or update operation. 

D Register import creates 
duplicates. 

Recheck the business key field mapping and confirm upsert mode was 
selected during import. 

E High validation issue count. Review task code links, the quality of the schedule import, and stage-
template assignment completeness. 

F P6 connection test fails. Verify the connection string, network access to the P6 server, and that 
the Admin profile credentials are correct. 

G S-curve shows no actual line. Confirm that Reg Rollup and Run Update were completed before the S-
Curve step in the progress cycle. 

H PDF report is extremely large. Export the exceptions-only summary; keep full detail in Excel. Reduce 
column count or split by area. 

 
13.3 Controlled Operating Routine 
Follow this routine discipline to maintain data integrity and report accuracy throughout the project 
lifecycle. 
 
Before any major import: 

• Create a database backup. 
• Confirm the correct project database is active. 
• Confirm the target project is selected. 

 
After any major import: 

• Review imported record counts and sample outputs. 
• Run Quality and Validation before proceeding. 

 
Before issuing any report: 

• Confirm project setup, cut-off date, and latest import status. 
• Verify Validation status is acceptable. 
• Review S-curve and tabular outputs against known project milestones. 

 

NOTE 
Keep screenshots in this manual current whenever a visible workflow or screen layout changes. An out-of-date 
manual creates confusion during training and onboarding. 
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14. Plan Versioning (Revisions, Rebaselines, Recovery Plans, 
and Forecasts) 
 
EPCplanner maintains a single live working plan (EPC_ACTIVITY and the Register stage dates) at all 
times — progress, S-curves, WF, and Reg Rollup always run against this active plan. Plan Versioning 
adds a controlled archive layer on top of this: every time a revised schedule is imported, EPCplanner can 
record it as a named, typed Plan Version with its own immutable snapshot, approval workflow, and audit 
trail. The active plan never loses history, and any earlier plan remains available for comparison, 
recovery, or audit. 
 
This chapter covers the Plan Version types, the approval lifecycle, the import workflow, the Revised Cut-
Off Date (“Lock Past”) mechanism used for Recovery and Rebaseline plans, the Plan Version Manager 
screen, and the comparison views available in the Register, S-Curves, and Reports modules. 
 
14.1 Plan Version Types 
Every imported schedule is recorded as one of five Plan Version types: 
Type Purpose 

Baseline The original approved project schedule. Created automatically as the first plan version on the 
project’s first P6/XER import. Always exists and is never deleted. 

Revision A formally numbered schedule revision issued during execution (Revision 1, Revision 2, etc.), 
reflecting approved changes to scope or sequence. 

Recovery A recovery plan issued to address schedule slippage. Normally imported with a Revised Cut-Off 
Date that locks actual progress as of that date (Section 14.4). 

Rebaseline A full schedule reset, formally approved by the Client or PMC, that becomes the new reference 
plan for future S-curves and reports. Also supports a Revised Cut-Off Date. 

Forecast An analytical “what-if” schedule scenario for reporting and comparison only. A Forecast plan can 
never be set as the Active plan. 

 

IMPORTANT 
A Forecast plan version can never become the Active controlling plan. EPCplanner enforces this at the 
database level — attempting to activate a Forecast plan is rejected. Use Forecast versions only for comparison 
overlays in S-Curves, Register, and Reports (Section 14.6). 
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14.2 Plan Version Lifecycle 
Each Plan Version (other than the original Baseline) moves through a controlled approval lifecycle before 
it can become the Active plan: 
Status Meaning 

Draft Created on import. Snapshot of activity and stage dates has been taken, but the plan is not yet 
visible outside the Plan Version Manager. 

Pending 
Approval 

Submitted for review. The plan is awaiting approval by a Project Controls Manager or 
Administrator before it can be activated. 

Approved Reviewed and approved. Ready to be set as Active by a Project Controls Manager or 
Administrator. 

Active The current controlling plan. Progress calculations, S-curves, WF, and Reg Rollup all run 
against this plan’s dates. Only one plan per project can be Active at any time. 

Superseded Was previously Active; replaced when a different plan was activated. Remains available for 
comparison and audit. 

Archived Retired from active use by a Project Controls Manager or Administrator. Remains available for 
comparison and audit; cannot be reactivated without Admin intervention. 

 

IMPORTANT 
Activating a plan version supersedes the current Active plan and triggers a full rebuild of plan progress, S-curve 
points, and WF spreads from the newly activated plan’s dates. This affects every project report. Activation 
should only be performed once the new plan has been formally approved. 

 

 
Figure 14.1 — Project menu, Plan Versions submenu. Entry points for Manage Plan Versions, Scope Change Review, and 

importing a schedule as a new Revision, Recovery Plan, Forecast, or Rebaseline (Section 14.3). 
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14.3 Importing a New Plan Version 
Plan Versioning is integrated into the existing P6/XER import workflow (Section 4) — no separate import 
process is required. 

• First-ever import for a project: EPCplanner automatically creates the Baseline plan version with no 
additional input required. 

• Any subsequent import: the Plan Revision dialog opens before the import proceeds. Select the 
Plan Type (Revision, Recovery, Rebaseline, or Forecast), enter a Plan Label (e.g. “Revision 1 — 
May-26”), and add optional Remarks. 

• Revised Cut-Off Date: for Revision, Recovery, and Rebaseline types, a date picker is shown, pre-
filled with the last closed Cut-Off Date. This date is used to lock past actual progress — see Section 
14.4. The picker is hidden for Forecast imports, since Forecast plans do not lock progress. 

• After the import completes, the new plan version is created in Draft status, a snapshot of activity 
dates and Register stage dates is taken, and the plan is automatically moved to Pending Approval 
— ready for review in the Plan Version Manager (Section 14.5). 
 

NOTE 
The existing import pipeline (XER parsing, activity mapping, spread calculation) is unchanged. Plan Versioning 
adds a snapshot and approval step before and after this pipeline — it does not alter how dates are imported or 
mapped. 

 
 

 
Figure 14.2 — Plan Version Manager screen. The Original Baseline is shown as the Active plan, with Log and Delete actions 

available for each plan version (Section 14.5). 
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14.4 Revised Cut-Off Date — Locking the Past 
When a Revision, Recovery, or Rebaseline plan is imported with a Revised Cut-Off Date (COD), 
EPCplanner locks the project’s actual progress as of that date before the new plan dates take effect. 
This ensures that historical S-curve points and reports remain accurate to what had actually been 
achieved, while the new schedule governs everything from the Revised COD forward. 
 
The lock is applied per activity, using the actual progress recorded at the closest closed Cut-Off Date on 
or before the Revised COD: 
Activity status at Revised COD Resulting plan progress 

Physically complete (100% complete, or Actual 
Finish on or before the Revised COD) 

Locked at 100% 

In progress (Actual Start recorded, percent 
complete greater than 0) 

Locked at its actual percent complete on that date 

Not yet started, and Early Start is on or after the 
Revised COD 

Reset to 0% — the new plan dates apply from the Revised 
COD forward 

Early Start before the Revised COD but no 
Actual Start recorded 

Treated as not started (0%) and flagged for review — check 
this activity’s actual dates before approving the plan 

Once the lock is applied, EPCplanner writes a permanent Revision Anchor record — a single immutable 
entry capturing the Revised COD, the project’s overall actual percent and earned Weight Factor at that 
date, and the plan that was Active immediately before this one. This anchor is the forensic zero-point for 
the new plan and is logged in the Plan Event Log as an ANCHOR_LOCKED event (Section 14.5). 
 

WARNING 
The Revision Anchor and the underlying activity/stage date snapshots are immutable evidence records — once 
written, they cannot be edited or deleted by any user, including Administrators. Review the Revised Cut-Off 
Date and any flagged activities carefully before approving a Recovery or Rebaseline plan, since the anchor 
cannot be corrected after the fact. If the Revised COD was wrong, raise a new plan version rather than 
attempting to alter the anchored one. 

 

 
Figure 14.3 — Import New Plan dialog. Select the Plan Type, enter a Label and Remarks, and set the Revised Cut-Off Date 

used to lock completed work as of that date (Sections 14.3 and 14.4). 
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14.5 Plan Version Manager 
The Plan Version Manager (Project Settings → Plan Versions) lists every plan version for the project and 
provides the approval and activation controls. 
 

• Header: shows the project name and a badge identifying the current Active plan. 
• Plan list: each plan version shows its Label, Type, Plan ID, Data Date, and current Status badge 

(Draft, Pending Approval, Approved, Active, Superseded, or Archived). 
• Submit: moves a Draft plan to Pending Approval, ready for review. 
• Approve / Reject: available on Pending Approval plans. Approve moves the plan to Approved 

status; Reject returns it to Draft for correction. 
• Set Active: available on Approved plans (except Forecast). Activating supersedes the current 

Active plan and triggers the recalculation described in Section 14.2. 
• Archive: retires a Draft, Approved, or Superseded plan. This cannot be undone. 
• Delete: permanently removes a Draft plan that has not yet been snapshotted. Available to 

Administrators only. 
• View Event Log: opens the Plan Event Log for the selected plan — an immutable, timestamped 

record of every lifecycle event (Imported, Submitted, Approved, Approval Rejected, Activated, 
Superseded, Archived, Anchor Locked, Spread Rebuilt, Stage Re-linked, Scope Diff Done, Integrity 
Checked) with the user who performed each action. 
 

NOTE 
The Plan Event Log is part of the project’s permanent audit trail and is referenced from the Audit Log (Section 
12.3) for governance and dispute resolution. 

 

 
Figure 14.4 — Scope Change Review dialog. Comparison is only available once a revision has been imported — the Original 

Baseline has no previous plan to compare against (Section 14.6). 
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14.6 Comparing Plan Versions 
Once more than one plan version exists for a project, comparison views become available across the 
Register, S-Curves, and Reports modules. Comparisons are always read-only — they do not change the 
Active plan or any live data. 
 

• Register: a “Compare with…” chip bar appears above the Register grid. Selecting an earlier plan 
version adds read-only Previous E-Date and L-Date columns alongside the active dates, plus a 
colour-coded Δ Days column showing how many days each stage has moved (amber = later, green 
= earlier) relative to the selected plan. 

• S-Curves: the S-Curve definition screen includes a Plan Version selector, allowing one S-curve per 
plan version to be overlaid on the same chart — for example, the Baseline curve alongside the 
Recovery Plan curve. 

• Reports: Register Summary and Excel exports accept a comparison plan selection and add an 
optional PlanComparison sheet showing the planned-date variance per stage between the selected 
plans. Each report’s header also displays the plan label, type, and data date it was generated 
against. 
 

TIP 
For Third-Party Register Validation involving a revised schedule, import the new XER as a Revision or 
Recovery plan first, complete the Stage Re-link review for any changed task codes, and only then proceed with 
Validation (Section 9.6) against the new active dates. 

 

 
Figure 14.5 — Plan Version Manager, Event Log. Each plan lifecycle event (e.g. Imported) is recorded with its date and 

responsible user (Section 14.5). 
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14.7 Roles and Permissions 
Action Required Role 

Import a new plan version (Revision, Recovery, 
Rebaseline, Forecast) 

Planner, Project Controls Engineer, Project Controls 
Manager, or Admin 

Submit a plan version for approval Planner and above 

Approve or reject a plan version Project Controls Manager, Admin 

Set a plan version as Active Project Controls Manager, Admin 

Archive a plan version Project Controls Manager, Admin 

Delete a Draft plan version (no snapshot) Admin only 

View the Plan Event Log Project Controls Engineer and above 

View plan comparison in Register, S-Curves, and 
Reports 

All roles with read access to that module 

 
These permissions follow the same 11-role model described in Table 12.1 — no additional roles are 
required for Plan Versioning. 
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1.  Tabular Progress Report 
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2. Progress S-Curves Report 
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3. Activities Behind Schedule Report 

 
4. Activities Lookahead Schedule Report 

 



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 78 

5. Resource Histogram Report 
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6. Register Summary Report 
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7. Register Reports 
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8. Register Lookahead Reports 
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9. Register Behind Schedule Reports 
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10. Bill Wise Invoice Progress Report (Summary/Details) 
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11. CBS Reports 
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Glossary 
The following terms are used throughout this manual and within the EPCplanner application. 

Term / 
Abbreviation 

Definition 

Activity A schedule element imported from Primavera P6 representing a discrete unit of work. 
Activities are the primary linkage point between Register items and the project schedule. 

Anchor (Revision 
Anchor) 

An immutable record created when a Revised Cut-Off Date is applied to a Revision, 
Recovery, or Rebaseline plan. Captures the project's overall actual percent complete and 
earned Weight Factor as of that date, plus the plan that was previously Active. Cannot be 
edited or deleted (Section 14.4). 

Baseline The approved original plan (dates, durations, weights) against which actual progress is 
measured. The baseline is locked when the project switches to In-Progress mode. 

CBS Cost Breakdown Structure. The lump-sum price schedule that maps contract line items to 
WBS/Activities for commercial progress measurement and invoice generation. 

COD Cut-Off Date. The reference date for a reporting period. All actual progress and stage 
dates entered within a period are validated against the open COD. The COD is locked 
(closed) at the end of each reporting cycle. 

ENG Engineering Register. Tracks document deliverables (drawings, datasheets, 
specifications) through a configured multi-stage review and approval workflow. 

EPC Engineering, Procurement and Construction. The project delivery model for which 
EPCplanner is purpose-built. 

EPS Enterprise Project Structure. The hierarchical project grouping in Primavera P6 used to 
organise and navigate projects when connecting EPCplanner to a live P6 database. 

Forecast (Plan 
Version) 

An analytical plan version type used for what-if scheduling and comparison only. A 
Forecast plan version can never be set as the Active controlling plan (Section 14.1). 

Freeze Guard An application control that prevents actual dates being entered outside the open COD 
window, protecting closed period data integrity. 

In-Progress Mode The operational state of a project in which the planning baseline is locked and actual 
progress tracking is active. Switched by an Administrator; a one-way action per project 
milestone. 

P6 / EPPM Oracle Primavera P6 Enterprise Project Portfolio Management. The industry-standard 
CPM scheduling tool with which EPCplanner integrates for schedule import and progress 
push-back. 

Plan Event Log An immutable, timestamped record of every lifecycle event for a plan version — import, 
approval, activation, supersession, archiving, and Revised Cut-Off Date locks. Viewed 
from the Plan Version Manager (Section 14.5). 

Plan Version A named, typed snapshot of the project schedule — Baseline, Revision, Recovery, 
Rebaseline, or Forecast — with its own approval lifecycle and date snapshot. Exactly one 
plan version is Active per project at any time (Chapter 14). 

PMC Project Management Consultant. An organisation engaged by the Client to oversee and 
audit EPC contractor performance. May be granted read-only or Client role access in 
EPCplanner. 

PROC Procurement Register. Tracks purchase requests and procurement packages through 
their lifecycle stages from requisition to delivery. 

Quality (Register) A structural check run on register items confirming that every item has a valid stage 
template and the required setup fields completed. Run as part of Section 9.6, before 
Validation. 



EPCplanner 2026  |  User Manual  |  V1.0                                          JUNE 2026 

Confidential — Internal Use Only Page 89 

Rebaseline A plan version type representing a full schedule reset, formally approved by the Client or 
PMC, that becomes the new reference plan for future S-curves and reports (Section 
14.1). 

Recovery Plan A plan version type issued to address schedule slippage, typically imported with a 
Revised Cut-Off Date that locks actual progress as of that date (Sections 14.1 and 14.4). 

Reg Rollup Register Rollup. The process that calculates physical progress for all register-linked 
activities from completed stage actuals, using the WF distribution. Must be run before 
Run Update in each progress cycle. 

Revised Cut-Off 
Date (Revised 
COD) 

The date used when importing a Revision, Recovery, or Rebaseline plan to lock actual 
progress before the new plan dates take effect. Triggers an ANCHOR_LOCKED Plan 
Event Log entry (Section 14.4). 

Revision (Plan 
Version) 

A plan version type representing a formally numbered schedule revision (Revision 1, 
Revision 2, etc.) issued during project execution (Section 14.1). 

Run Update The action that calculates overall Activity progress as of the COD, combining linear 
progress and Reg Rollup results. Run after Reg Rollup and before S-Curve in the update 
cycle (Section 8.5). 

S-Curve A cumulative progress curve showing planned versus actual progress over time. 
Generated by EPCplanner from WF-based rollup data after each reporting period. 

SUBC Subcontractor Register. Tracks subcontract work packages and deliverables through 
configurable stage gates agreed in the subcontract terms. 

Upsert Update-or-Insert. An import mode that updates an existing record if its business key 
already exists, or inserts it as a new record if it does not. Prevents duplicate creation 
during repeat imports. 

Validation 
(Register) 

A check run on register items that compares each item's generated stage dates against 
its linked Primavera activity dates, reporting any misalignment as a day-delta. Run as part 
of Section 9.6, after Quality. 

WBS Work Breakdown Structure. The hierarchical decomposition of project scope imported 
from Primavera P6 and used as the primary organising structure for CBS, Register, and 
progress reporting. 

WF / Weight 
Factor 

A numerical weight assigned to an activity or stage gate that represents its proportional 
contribution to overall project progress. WF values sum to 100% across the defined 
scope and drive S-curve generation, rollup, and progress reporting. 

XER The native Primavera P6 export format. EPCplanner accepts XER files directly for 
schedule import, supporting all P6 versions that produce a standard XER export. 
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Recommended Implementation Sequence 
This sequence represents the recommended order for configuring and activating EPCplanner on a new 
project. Follow these phases in order to ensure each module has its prerequisite data in place before use. 
 

Phase Task Notes 

1 Licensing & 
Installation 

Install EPCplanner on the designated workstation. Activate the machine 
licence. Confirm the Admin account is operational before any other user 
access is granted. 

2 User Accounts Create all required user accounts with appropriate roles (see Table 12.1). 
Distribute credentials to each user and confirm first-login password change is 
completed. 

3 Create Project 
Database 

Create the project database via File → New Project. Name the file clearly 
using project code and revision. Store in a managed shared folder or secure 
local directory. 

4 Project Setup Complete all Project Setup fields (Section 5): project name, client/company 
numbers, revision, cut-off logic. This metadata appears on all generated 
reports. 

5 P6 Import (XER) Import the approved baseline XER (Section 4.1). Review WBS structure, 
activity IDs, calendars, and relationships. Back up the database after a 
successful import. 

6 CBS Setup Import and promote the contract CBS (Section 7.1–7.5). Map CBS items to 
WBS/Activities via CBS Distribution (Section 7.6). Generate WF from CBS 
(Section 7.7). 

7 Weight Factors Import or generate WF data (Section 6). Validate total distribution = 100%. 
Run Transfer WF to align register and activity WF. Verify WF Alignment 
before proceeding. 

8 Register Setup Import ENG, PROC, and SUBC register items (Section 9.3). Create or import 
stage templates (Section 9.4). Assign templates and link task codes (Section 
9.5). Generate dates, run Quality and Validation (Section 9.6). 

9 Baseline 
Verification 

Review all S-curve planned data, register planned dates, and WF totals 
against the approved baseline. Obtain formal sign-off before switching to In-
Progress mode. Back up the database. 

10 Switch to In-
Progress 

Admin switches the project to In-Progress mode (Section 8.1). Open the first 
COD and begin the reporting cycle. The project is now live. 
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Administrator Pre-Deployment Checklist 
Complete all items in this checklist before granting operational access to project team members. Each 
item must be confirmed by the system administrator and documented with date of completion 
. 

# Checklist Item Verified By Date 

1 EPCplanner installed on target workstation(s). Version 
confirmed: 2026.1.0 or later. 

    

2 Machine licence key generated, activated, and validated on 
the target machine. Licence fingerprint recorded. 

    

3 Admin account default password changed. Admin credentials 
stored securely (not distributed to general users). 

    

4 All user accounts created with correct role assignments. 
Temporary passwords distributed individually. First-login 
password change confirmed for all active users. 

    

5 Project database created and stored in a managed directory. 
File naming convention applied (project code + date). 

    

6 Backup folder created and backup routine confirmed. At 
minimum one manual backup taken and verified as 
restorable. 

    

7 Project Setup fully completed: all identity fields, cut-off logic, 
and reporting parameters. Reviewed against project master 
document register and contract data. 

    

8 P6 XER import completed and reviewed. WBS, activity 
counts, calendars, and relationships verified against the 
source P6 schedule. 

    

9 CBS import, validation, and promotion complete. CBS 
Distribution mapping verified. CBS WF generated and total 
distribution confirmed = 100%. 

    

10 Register import, template assignment, and date generation 
complete. Quality confirmed ≥90% coverage. Validation 
issues reviewed and either resolved or documented with 
justification. 

    

11 S-curve planned data reviewed and confirmed against the 
project baseline. Print settings configured. Sample report 
generated in HTML and PDF and reviewed for layout and 
correctness. 

    

12 Baseline database backup taken after all setup is complete 
and verified. Backup labelled as 
“[ProjectCode]_Baseline_[Date]” and stored in a secure off-
machine location. 

    

13 All key users trained or briefed on their module 
responsibilities. Controlled Operating Routine (Section 13.3) 
shared with all users and acknowledged. 

    

14 In-Progress mode switched by Administrator. First Cut-Off 
Date opened. Project team authorised to begin operational 
use. 
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Enterprise Release Improvement Notes 
This section records known limitations, planned enhancements, and release improvements noted during 
the Pilot Phase. Items are categorised by priority. The Pilot Phase is the primary mechanism for collecting 
field feedback that shapes the General Availability (GA) release. 
 
Confirmed for GA Release (Roadmap) 

# Area Planned Enhancement Target 

1 Project Dashboard Consolidated project health dashboard aggregating 
progress, CBS, and Register KPIs in a single view with 
export to PDF. 

GA Release 

2 Session Timeout Auto-logout after configurable inactivity period to meet 
enterprise security policy requirements. 

GA Release 

3 Code Signing Installer and executable signing with a recognised EV 
certificate to eliminate Windows SmartScreen warnings in 
enterprise deployment environments. 

GA Release 

4 Long-Run Stability Planned 6–12 hour endurance test covering import cycles, 
report generation, navigation, and concurrent P6 
synchronisation to validate memory stability under 
continuous use. 

Post-Pilot 

 
Pilot Phase Feedback Mechanism 
Pilot organisations are requested to report issues and improvement suggestions using the following 
categories to assist prioritisation: 
 
P1 — Critical: Data loss, calculation error, or blocking defect that prevents productive use. 
 
P2 — High: Workflow disruption or incorrect output that requires a workaround. 
 
P3 — Enhancement: Feature request or usability improvement that would improve productivity but does 
not block current work. 
 
All feedback should include: the module name, a description of the observed behaviour, expected 
behaviour, and the steps to reproduce. Submit to the EPCplanner product team via the contact provided 
with your pilot agreement. 
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